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One of Windows 8's biggest drawbacks was that it forced people with
desktop computers to use an interface designed for tablets. In Windows 10,
Microsoft changes that with a feature called Continuum that automatically
senses the device you're using and switches Windows 10's interface to
match it — the Windows 8-like Start screen for tablets, and the desktop
and Start menu for laptops and desktops.
Continuum works dynamically. If you're using a tablet with a keyboard
attached, such as a Microsoft Surface, it displays the desktop interface, but
if you detach the keyboard, it asks if you want to switch to tablet mode,
which uses the Start screen interface. Tap "Yes" to switch to tablet mode.
Similarly, if you're using a tablet and attach a keyboard to it, a notiﬁcation
appears asking if you want to switch out of tablet mode.
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Windows 10 senses when you detach a keyboard from a 2-in-1
device and asks if you want to switch to tablet mode. (Click image
to enlarge.)
If you don't want to be bothered by the notiﬁcation again, select
"Remember my response and don't ask again." From then on, you'll switch
automatically from desktop to tablet mode and back again depending on
whether you have a keyboard attached to your device. No notiﬁcation will
appear. If for some reason you like those notiﬁcations, instead select
"Always ask me before switching."
You can also manually switch in and out of tablet mode via an icon in the
Action Center, which I'll cover in the next section of the story.
Tablet mode in Windows 10 works much like Windows 8 used to work, with
the usual touch and swiping gestures. As with Windows 8, there's no
desktop but instead the Start screen with groups of tiles that represent your
apps — the same tiles grouped in the same way as they are on the
desktop's Start menu, except here they take up the full screen. Tap any tile
to launch it. You can scroll through the tiles, but note that they scroll
vertically rather than horizontally as they did in Windows 8.
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Tablet mode in Windows 10 features the Start screen, which will
be familiar to Windows 8 users. (Click image to enlarge.)
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There are some other di erences between the Start screen in Windows 10's
tablet mode and the old Windows 8 Start screen. On the left side of the
screen you’ll ﬁnd six icons, three grouped at the top and three at the
bottom.
At the top is a hamburger menu, which doesn’t serve much purpose. Tap it,
and the left-hand side of the screen turns black, and all six icons get text
labels. Tap it again, and the labels and black screen go away. Just beneath
the hamburger menu is the pinned tiles icon — tap it to see the Start screen
ﬁlled with tiles, which is the default tablet interface. Below the pinned tiles
icon is the all apps icon. Tap it and instead of seeing pinned tiles, you get a
full-screen all apps view that lets you scroll through all of your apps and
desktop applications to quickly ﬁnd one you want.
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You can see the all apps listing even on a tablet. (Click image to
enlarge.)
Down toward the bottom of the screen are three icons that will be familiar
to those who use the desktop and laptop interface: One for your user
account, so you can sign out of Windows, lock your PC, switch to a di erent
user account, or change your account settings; one that gets you to the
Settings app; and a power icon that that lets you put your tablet to sleep,
shut it down or restart it.
You can also auto-hide the taskbar when you're in tablet mode, even if you
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Settings > System > Tablet Mode and switch on the setting "Automatically
hide the taskbar in tablet mode.”

The Action Center, My People and Task View
Windows 10 has a few other new interface tricks up its sleeve that are worth
knowing about.
The Action Center
In Windows 8, you got to system settings and other behind-the-scenes
tools via an awkward interface called the Charms bar. In Windows 10 it's
been replaced by the Action Center, which you may or may not ﬁnd useful.
But you should at least know what it is and how it works so you can make
your own decision.
There are three ways to launch it:
Swipe from the right on a touch-based device.
Click its icon on the far right in the taskbar. (It looks like a rectangular
word balloon.)
Press Windows key + A.
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The Action Center springs up with a swipe, a click or a keyboard
combo. (Click image to enlarge.)
The Action Center is designed for double duty: It displays notiﬁcations for
such things as your news feed, new emails, and security and maintenance
messages, and it lets you change a handful of common settings for such
tasks as connecting to Wi-Fi networks, switching to and from tablet mode,
and changing brightness settings.
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Notiﬁcations ﬁrst appear on their own on the lower right of the desktop
and disappear after a few seconds. You may or may not want to click them
right away, which is where the Action Center comes in. After they fade away
on the desktop, they live on in the Action Center.
Security and system notiﬁcations are generally well worth heeding. For
example, you may be told that you can speed up your PC by stopping
unnecessary programs from launching at startup. Tap the notiﬁcation and
you'll be sent to the Task Manager, which lets you stop them from running.
The alerts also tell you when you've got printer woes, issues with
Microsoft's OneDrive cloud-based storage or similar problems. So overall,
you'll probably ﬁnd it worth your time to regularly check the Action Center.
As for email, you might ﬁnd those notiﬁcations less than useful, because
the Action Center doesn't always play well with your mail provider. If
you've set up the Windows 10 Mail app to hook into your Gmail account,
you will see a notiﬁcation in the Action Center when that account gets new
email. When you click the notiﬁcation, the Mail app launches and you can
read the message there. But the Action Center doesn't take into account
whether you've already checked your Gmail account in a browser, so you'll
continue to see notiﬁcations for messages you've received, even if you've
already read them in Gmail and deleted them.
That said, there is a way to suppress Mail notiﬁcations from the Action
Center, which I'll cover below.
More useful are the icons for quick actions at the bottom of the Action
Center. Just click the icon of the action you want to perform. Most are selfexplanatory, such as starting a new note or turning Bluetooth on or o .
By default, four icons appear in the top row of the quick-actions area. To
show icons for all the quick actions available to you in the Action Center,
click "Expand" just above the row of quick action icons. All of the
remaining quick-action icons will appear. The exact icons that appear
depend upon the capabilities of the computer that you're using. On a
desktop PC, for example, you might only have eight or so quick-action
icons, but on a laptop or tablet there will likely be more icons available for
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display only a single row of icons when the Action Center is expanded, click
Collapse.
To change which ones appear in the row, click the "All settings" icon, then
go to the System group, click "Notiﬁcations & actions" and look at the area
at the top of the screen labeled “Quick actions." You’ll see all of the quick
icons you have displayed in the Action Center. To add or remove any quick
actions, click “Add or remove quick actions” and make your selections. You
can also change each icon’s position in the Action Center. Simply drag it to
the location where you want it to appear.
You can also change which notiﬁcations show up in the Action Center, or
turn them o

completely. Go to Settings > System > Notiﬁcations &

actions, and to turn o

notiﬁcations, turn the slider to o

in the “Get

notiﬁcations from apps and other senders” section. Turn the slider to on to
get notiﬁcations. Then scroll down and select the kinds of notiﬁcations you
want to see and turn o

the ones you don't want to see. You'll be able to

choose or hide general types, such as Windows tips or app notiﬁcations, or
turn o

and on notiﬁcations from individual apps, including Mail. To do the

latter, scroll to the "Get notiﬁcations from these senders " section and
toggle them On or O .
You can also set priorities for which apps are more important than others
and have their notiﬁcations show up at the top of your notiﬁcation lists. Go
to Settings > System > Notiﬁcations & actions, then scroll down to the "Get
notiﬁcations from these senders" section and double-click an app. A new
screen appears which lets you ﬁne-tune how that app’s notiﬁcations are
displayed At the bottom of the screen you'll see settings for three levels:
Normal, High and Top, with Normal being the lowest priority and Top the
highest. Choose the one you want.
You can also adjust how many notiﬁcations can be visible at any time in the
Action Center for any app. The default is three. To change it, from the same
screen, click "Number of notiﬁcations visible in action center," and select a
number from the dropdown list (you can choose one, three, ﬁve, 10 or 20).
My People
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The Windows 10 Fall Creators Update introduced a new feature called My
People that lets you pin contacts to the Windows taskbar, and then
communicate with them without having to open a separate app.
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With the People app, you can pin contacts to the taskbar to make
it easier to contact them in multiple ways. (Click image to
enlarge.)
To use it, click the People button on the right side of the taskbar — it looks
like the heads and shoulders of two people. (If the button isn’t visible,
right-click the taskbar and from the screen that appears and select the
Show People button.)
The ﬁrst time you use the app, a Get Started button appears. Click it, then
click People at the top of the screen that appears. On top of the screen is a
list of people you’ve frequently contacted. Click a contact to pin him or her
to the taskbar. (To pin other contacts, click “Find and pin contacts” at the
bottom of the screen. That leads to a search box that lets you search for
contacts to pin.)
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Once that’s done, the contact is pinned to the taskbar. (To unpin a contact,
right-click it and select “Unpin from taskbar.”) You’ll now be able to
communicate with him or her without having to open a separate app such
as Mail or Skype. Just click the icon for the person with whom you want to
communicate, and in the contact information page that opens, choose the
app you want to use. You’ll be able to get in touch from right inside the
contact info page.
You can scroll through your history of communications with the contact.
You’ll see all messages you two have exchanged in a threaded list. It
includes communications such as Skype video chats and instant messages,
not just email.
Task View and multiple desktops
Some people might ﬁnd one more Windows 10 addition useful — Task View
and its ability to create multiple desktops. To activate Task View, click its
icon (a large rectangle with two smaller rectangles ﬂanking it) in the
taskbar just to the right of the search bar or press Windows key-Tab. When
you do so, Task View shows thumbnails of all of your currently running
apps and applications arrayed against the desktop so you can quickly see
what you've got running. Click any to switch to it or press the Esc key to
leave Task View and return to where you were.
For those used to using the old Alt-Tab key combination to cycle through
open apps and applications, you can still do that as well, but Task View
adds a couple of extra twists. If you hover your mouse over any thumbnail,
a small X appears in its upper-right corner. Click the X to close that app or
application.
Task View also lets you create multiple virtual desktops, each with di erent
Windows apps and desktop applications running on them. To create a new
desktop, activate Task View and click "New desktop" at the lower right of
the screen. You can run a di erent set of Windows apps and desktop
applications inside the new desktop — for instance, you could dedicate one
desktop to work-related apps and applications, and another desktop to
entertainment-related apps and applications.
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The new Task View in action: Virtual desktops are shown across
the bottom, and the apps running in the current desktop appear
up top. (Click image to enlarge.)
To switch between desktops, click the Task View icon and click the desktop
to which you want to switch. You can keep creating new desktops this way
and switch among them.
One odd thing to keep in mind about virtual desktops is that you can't run a
Windows app in multiple desktops simultaneously. If it's running in one
desktop and you try to launch it in another, you'll immediately zoom to the
desktop in which you originally launched it. You can, however, run desktop
applications in multiple desktops.

The Edge browser
With Windows 10, Microsoft ﬁnally bids goodbye to Internet Explorer —
almost. You'll still ﬁnd it, but it's no longer the default browser, and
development work has essentially stopped on it. The browser of today and
tomorrow is Edge.
Edge is a considerable improvement over Internet Explorer. It's faster,
cleaner-looking and downright Chrome-like in its stripped-down design.
It's generally intuitive to use. The upper left has arrows for going forward,
back and reloading a page. Type URLs in the address bar or use the address
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Directly to the right of the address bar you'll ﬁnd an icon of a book, which
launches one of Edge's most useful features: Reading View. Like similar
features in Safari and Firefox, it strips out everything extraneous to a
page's content, including ads, navigation, sidebars and anything else that
diverts attention from the content. Text and graphics appear in a scrollable
window. Its icon will be grayed out if you're on a page that Reading View
can't handle, such as a page that is primarily used for navigation.
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Here's how an article looks in Edge normally (left) and how it
looks in Reading View (right). (Click image to enlarge it.)
Edge has another new feature that you may or may not ﬁnd as helpful as
Reading View: the ability to annotate and share web pages. With it, you can
mark up a page using highlighters and note-creation tools, save the
annotated page and share it as a JPG graphic ﬁle via email, OneNote or
Twitter.
Click the annotation icon to the right of the menu icon — it looks like a
pencil and paper — and the annotation tools appear. When you're done
annotating, click the Share icon, just to the left of the Exit button on the
top right of the screen. Then select how you want to share the annotation,
and follow the instructions. When you want to exit annotation mode, press
the Esc key or click Exit.
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You can mark up a web page with Edge's annotation tools. (Click
image to enlarge it.)
One of Edge's more useful features is its behind-the-scenes integration
with Cortana. When you browse to a page for which Cortana can o er help,
a Cortana icon appears at the top of the page, along with a note, such as
"I've got directions, hours, and more" if you're on a restaurant page. Click
the icon and a sidebar appears on the right side of the page with additional
information — for example, a map, address, phone number and reviews for
a restaurant, in addition to links for getting directions, viewing the menu
and calling the restaurant.
Microsoft hasn't completely given up on Internet Explorer, because some
enterprises have standardized on it, and some enterprise apps require that
browser to work properly. So there's a way to launch Internet Explorer
when you're visiting a web page. Click the icon with three dots on the upper
right of the screen, and from the menu that appears, select "Open with
Internet Explorer." Internet Explorer will launch with the current page in it.
As for the rest of Edge, it's straightforward to use. To get to your history,
favorites and downloads, click the icon of a star with three horizontal lines
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the icon of a right-facing arrow just to the right of the annotation icon. And
for more menu choices, including zooming in and out, ﬁnding text on a
page, changing settings, and more, click the three-dot icon.
[ Related: How to replace Edge as the default browser in Windows
10 — and why you should ]
When Windows 10 was released, Edge didn’t support add-ins and
extensions as Chrome and Firefox do, a serious drawback. However, with
the Windows 10 Anniversary Update, released in August of 2016, Edge
ﬁnally got extension support. That’s the good news. The bad news is that
the support is quite weak — as of late January 2018, nearly a year and a half
after Edge ﬁrst got extensions, there were only 111 of them, compared to
many thousands for Chrome and Firefox.
Still, at least they’re there, and it’s easy to take advantage of them. To do it,
when you're in Edge, click the three-dot icon at the top right of the screen.
From the menu that appears, choose Extensions > Get extensions from the
Store. You'll see icons for each extension available. Click any icon for more
details, then click the button that says “Get” to download it. After the
download, click the "Turn it on" button that pops up to enable the
extension.
To customize how an extension works or uninstall it, click Edge’s menu
button and choose Extensions > Get extensions from the Store. You’ll see a
list of all of your extensions. Click the gear icon next to the extension you
want to customize and from the screen that appears, choose your
customization option, or click Uninstall to uninstall it.
Edge, by default, disables Adobe Flash to improve security and
performance. However, if you’d like, you can enable it on a site-by-site
basis. When you visit a site that has Flash, a small window appears in the
right of the address bar, with a message telling you Flash has been blocked.
Click the small icon of a puzzle piece in the address bar to turn on Flash for
the site. When you do that, you’ll have the option of running it only once,
or every time you visit the site.
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The Windows 10 Anniversary Update also introduced some useful tabhandling features to Edge. To see a thumbnail of every open tab, click a
down arrow to the right of the Add Tab button at the top of the screen. That
lets you quickly scan all the currently open sites. Click the thumbnail of the
tab you want to switch to, and you get sent immediately to that tab.
Should you decide to close all your open tabs, but think you might want to
revisit them later, click a button to their left at the top of the screen that
shows a window with a left-facing arrow on it. That puts them aside as a
group. When you want to open the group again, click a button to the left of
that one, and they all open. You can recall the tab group even after you've
closed Edge — in fact, even after you've logged out of Windows.
What makes this feature even more useful is that you can do this to
multiple groups of tabs. So, for example, you might want to create a group
of museum sites, another for medical sites, and so on. After you create the
groups, you can revisit them later, even after you’ve closed a browsing
session.
You can also read books and other content in ePub and PDF formats from
right inside Edge. The built-in e-reader gives you the usual e-reading
features, such as the ability to continue reading where you had previously
left o , change text size and so on. It will also read text aloud.
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Edge’s epub reader in action. (Click image to enlarge it.)
To use it, click the icon of a star with three horizontal lines just to the right
of the address bar, and from the screen that drops down, click the icon of
three books. Then click the “Get books” button, which brings you to the
Books section of the Microsoft Store. Buy a book, and to read it, come back
to the e-reader, as I just described. The top of the page will have a variety
of icons for searching, reading aloud and so on. It’s all self-explanatory and
easy to do. Note that if you download e-books in ePub format, or PDFs, you
can read them from here as well.
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